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Figure 5.79  Unselect the Laser 

 

NOTICE 

� If you cannot set the laser to be at its minimum focus, it’s probably because the 
focal length is long. To shorten the focal length, slightly turn the sliver lens screw 

(as shown in Figure 5.80) on the bottom of the laser kit. 

 

Figure 5.80  Adjust the laser focus 

 

� The point marked by a red box, as shown in Figure 5.81, corresponds to the 

position of the end-effector of the Dobot Magician. This point changes its position 

only within the annular area when the robotic arm moves. 

 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 79  

 

Figure 5.81  The point corresponding to the end-effector of the robotic arm 

 

 Step 4 Click AutoZ on the Write & Draw page to obtain and save the current value of Z 

axis.  

Once this step is complete, the next time you start to engrave, directly import a PLT 

or SVG image file without adjusting the position of the laser kit, and click 

SyncPos, and then click Start to start engraving on the paper, as shown in Figure 

5.82. 

 

Figure 5.82  Lock the height of engraving 

 

�NOTE 

The value of the Z axis is the PenDown parameter. This parameter can be set by 

selecting Setting > Write Draw > PenDown on the Write & Draw page, as shown in 

Figure 5.83. If the effect of engraving is not satisfactory, slightly raise and lower the 

height of the laser kit or directly change the value of PenDown. 
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Figure 5.83  Set the PenDown parameters 

 

 Step 5 Click SyncPos. 

The Dobot Magician automatically moves above the position (PenUpOffset) of the 

start point of the laser-engraving. 

 Step 6 Click Start to start engraving on the paper. 

When engraving, click Pause to pause the engraving and Stop to halt the 

engraving. 

Figure 5.84 shows the effect of the laser-engraving. 
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Figure 5.84  The effect of the laser-engraving 

 

 Engraving a Grayscale Image 5.6
Figure 5.85  shows the process of engraving a grayscale image. 

 

Figure 5.85  The process of engraving a grayscale image 
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 Installing a Grayscale-engraving Kit 5.6.1

Both grayscale-engraving and laser-engraving use the laser kit as the end-effector. For the 

installation method, see 5.5.1 Installing a Laser Kit. 

 Connecting the DobotStudio 5.6.2

 Step 1 Launch the DobotStudio, and select the COM port, and then click Connect. 

If the current firmware of the Dobot Magician is the 3D Printing firmware instead 

of the Dobot firmware, the Select tool dialog box is displayed, asking if you want 

to switch to the Dobot firmware. In this case, perform the following steps to switch 

to this firmware. 

 Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.86. 1.

The Question dialog box is displayed. 

 

Figure 5.86  Select the DobotStudio to upgrade the Dobot firmware 

 

 Click OK, as shown in Figure 5.87. 2.

The Dobot firmware upgrade window is displayed. 

 

Figure 5.87  Confirm the firmware upgrade 

 

 Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.88. When 3.

the upgrade process bar shows 100%, and a short beep sound is heard, it means 

that the firmware is upgraded successfully, as shown in Figure 5.89. In this 

case, the LED indicator turns from red to green. Then click Quit to exit. 
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Figure 5.88  Click Confirm 

 

 

Figure 5.89  The firmware upgrade is successful 

WARNING 

During the firmware upgrade, do not stop it. Otherwise, errors occur. 

 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 84  

 Step 2 Click LaserEngraving, as shown in Figure 5.90. 

 

Figure 5.90  Click LaserEngraving 

 

 Importing Image Files and Setting Engraving Parameters 5.6.3

Prerequisites 

An image file has been created. 

Procedure 

NOTICE 

The imported image should be placed within the annular area on the LaserEngraving 
page, as shown in Figure 5.91. If not, the robotic arm reaches its limited position and 

thus cannot engrave on an object. In this case, the image is highlighted with a red 

border, as shown in Figure 5.92. 
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Figure 5.91  The image file is located within the annular area 

 

 

Figure 5.92  The image file is located outside the annular area 

 

 Step 1 Choose Laser as the end-effector on the LaserEngraving page, as shown in Figure 

5.93. 
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Figure 5.93  Choose Laser as the end-effector 

 

 Step 2 Click Open to import an image file such as BMP, JPEG, or PNG, as shown in 

Figure 5.94. 

 

Figure 5.94  Import an image file 

 

 Step 3 Set the Grayscale range, Laser power range, and Border, as shown in Figure 

5.95. For details, see Table 5.11. 

 

Figure 5.95  Set the grayscale range, laser power range, and border 

 

Table 5.11  Laser engraving parameters 

Items Description 

Grayscale range Set the grayscale range 
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Items Description 

Range: 0 - 255 

Default value: 20 - 240 

Laser power range Set the laser power range 

Range: 2 - 100 

Default value: 20 - 90 

Border Set the border width. 

Unit: pixel 

Range: 0 - 50 

Default value: 4 

 

 Step 4 Set the laser-engraving parameters. 

 Click Setting on the LaserEngraving page. 1.

 Set the JunctionVel (junction velocity), PlanAcc (linear acceleration), and Acc 2.

(acceleration), for example, set all to 5, as shown in Figure 5.96. 

 

Figure 5.96  Set the parameters of laser engraving 

 

 Adjust the Laser Focus and Start to Engrave 5.6.4

 Step 1 Click  to display the Operation Panel, and then select Laser to turn on the 

laser, as shown in Figure 5.97. In this case, the laser gives out a laser beam. 
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 Danger 

� When using a laser, wear lasing protective eyeglass. 

� Never aim the laser at a person’s eye and clothes or stare at the laser from 
within the beam. 

� In the central laser focus, a high-temperature heat is created and can burn 

materials such as papers and wooden boards. 

� Never aim the laser at a person and their clothes. 

� Do not allow the children to play with the Dobot Magician. Monitor the 

robotic arm while it is running and power off it once the movement is 

complete. 

 

 

Figure 5.97  Select the Laser 

 

 Step 2 Adjust the laser focus. 

Press and hold the unlock button  on the Forearm to move the robotic arm to 

raise and lower the height of the laser kit until the laser is the brightest with a 

smallest possible spot size. When the laser power level is high enough, the laser 

beam can burn and cut the paper. After getting a pretty good focus, unselect Laser 

on the Operation Panel page to turn off the laser, as shown in Figure 5.98. 
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Figure 5.98  Unselect the Laser 

 

NOTICE 

� If you cannot set the laser to be at its minimum focus, it’s probably because the 
focal length is long. To shorten the focal length, slightly turn the sliver lens screw 

(as shown in Figure 5.99) on the bottom of the laser kit. 

 

 

Figure 5.99  Adjust the focus 

 

� The point marked by a red box, as shown in Figure 5.100, corresponds to the 

position of the laser kit of the Dobot Magician. This point changes its position only 

within the annular area when the robotic arm moves. 
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Figure 5.100  The point corresponding to the laser kit of the robotic arm 

 

 Step 3 Click AutoZ on the LaserEngraving page to obtain and save the current value of 

the Z axis.  

Once this step is complete, the next time you start to engrave, directly import an 

image file without adjusting the position of the laser kit, and click SyncPos, and 

then click Start to start engraving on the paper, as shown in Figure 5.101. 

 

Figure 5.101  Lock the height of engraving 

 

�NOTE 

The value of Z axis is the PenDown parameter. This parameter can be set by selecting 

Setting > LaserEngraving > PenDown, as shown in Figure 5.102. If the effect of 

engraving is not satisfactory, slightly raise and lower the height of the laser kit or 

directly change the value of PenDown. 
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Figure 5.102  Set the PenDown parameters 

 

 Step 4 Click SyncPos. 

The Dobot Magician automatically moves above the position of the start point of 

the laser-engraving. 

 Step 5 Click Start to start engraving on the paper. 

When engraving, click Pause to pause the engraving and Stop to halt the 

engraving. 

Figure 5.103  shows the effect of the laser-engraving. 
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Figure 5.103  The effect of laser-engraving 

 Controlling with your Hand Gesture 5.7
You can use the LeapMotion function module of the DobotStudio to perform tasks, for 

example, grab or suck an object with your hand gesture. 

 Installing a Leap Motion Controller 5.7.1

Prerequisites 

� The Leap Motion controller (a hand gesture controller) has been obtained. 

� The Leap Motion driver software has been obtained. Download the Windows version, as 

shown in Figure 5.104, from the https://www.leapmotion.com/setup/desktop/windows. 

 

Figure 5.104  Download the Leap Motion driver software for Windows  

 

Procedure 

 Step 1 Connect a Leap Motion controller to your computer with a USB cable, and put it on 

the work surface with its face up, as shown in Figure 5.105. 
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Figure 5.105  Connect the Leap Motion controller to your computer 

 Step 2 Install the Leap Motion driver software by following the on-screen instructions, as 

shown in Figure 5.106. 

 

Figure 5.106  The Leap Motion Installation Interface 

 

 Leap Motion Demo 5.7.2
You can move or sort an object with the LeapMotion function. This topic introduces how to 

move a small cube with a hand gesture. 

Prerequisites 

� The Dobot Magician is powered on and connected to your computer. 

� The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Procedure 

 Step 1 Launch the DobotStudio, and click Connect to connect to the Dobot Magician. 

 Step 2 Click LeapMotion, as shown in Figure 5.107. 
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Figure 5.107  Click LeapMotion 

 

 Step 3 Click Setting on the DobtStudio page, as shown in Figure 5.108. 

 

Figure 5.108  Click Setting 

 

 Step 4 Click Leap Motion, as shown in Figure 5.109. Set the parameters, as shown in 

Table 5.12, and click OK. 
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Figure 5.109  Set the parameters of the Leap Motion function 

 

Table 5.12  Set the parameters of the Leap Motion function 

Items Description 

Speed The velocity percentage of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 50 

Scale The scale of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 100 

High performance/Low 

performance 

Choose a performance mode suitable for your computer. Select the Low 

performance (default) for the low configuration computer to prevent 
video delay 

 

 Step 5 Choose SuctionCup as the end-effector on the DobotStudio page, and click Start 
to control the Dobot Magician with your hand gesture, as shown in Figure 5.110. 

To maintain the Dobot Magician in a stable state, move your hand into the 

workspace of the Leap Motion controller while keeping your palm upward. And 

turn your palm down, and then move your hand above this area to control the 

Dobot Magician. 
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Figure 5.110  Click Start 

 

� NOTE 

Move your hand in the workspace of the Leap Motion controller to control the Dobot 

Magician to perform a particular task, as shown in Table 5.13. 

 

Table 5.13  The robotic arm’s movement created with your hand gesture 

Hand gesture Robotic arm’s movement 

Move your palm up, down, front, 

back, right, or left 

The robotic arm moves accordingly 

Clench your fist Control the air pump to suck air 

Unclench your fist Turn off the air pump 

 

 Step 6 Put a small cube on the work surface in the workspace of the Dobot Magician, such 

as point A, and use the hand gesture to move robotic arm above the cube until it’s 

close to the cube. 

 Step 7 Clench your fist to control the air pump to suck the small cube, and move your fist 

to make Dobot Magician take the cube to another position while clenching your 

fist, such as position B, and then unclench your fist to turn off the air pump to drop 

the cube. 

 Step 8 Turn your palm upward and click Stop to stop the hand control. 

 Controlling with your Mouse 5.8
You can use the Mouse function module of the DobotStudio to perform tasks, for example, 

grab or suck an object with your mouse. This topic introduces how to move a small cube with 

a mouse. 
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Prerequisites 

� The Dobot Magician is powered on and connected to your computer. 

� The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit. 

Procedure 

 Step 1 Click Mouse, as shown in Figure 5.111. 

 

Figure 5.111  Click Mouse  

 

 Step 2 Choose SuctionCup as the end-effector on the DobotStudio page, as shown in 

Figure 5.112. 

 

Figure 5.112  Choose SuctionCup as the end-effector 

 

 Step 3 Click Setting, as shown in Figure 5.113. 
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Figure 5.113  Click Setting 

 

Click Mouse, as shown in Figure 5.114. Set the parameters, as shown in  

 

 

Table 5.14, and click OK. 

 

Figure 5.114  Set the parameters of mouse control 
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Table 5.14  Set the parameters of mouse control 

Parameters Description 

Speed The velocity percentage of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 50 

Scale The scale of the Dobot Magician: 

Unit: % 

Value range: 1 - 100 

Default value: 100 

High 

performance/Low 
performance 

Choose a performance mode suitable for your computer. Select Low 
performance (default) for the low configuration computer to prevent video delay 

 

 Step 1 Put a small cube on the work surface in the workspace of the Dobot Magician, such 

as point A. 

 Step 2 Press V to enable the mouse control of the Dobot Magician. Press and hold the left 

mouse button to drag the mouse within the red annular area to move the robotic 

arm, as shown in Figure 5.115. 

 

NOTICE 

Do not move the mouse outside the red annular area. If not, the robotic arm reaches its 

limited position. In this case, drag the mouse to into the annular area. 
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Figure 5.115  Move the robotic arm in the red annular area 

 

 Step 3 Move the Dobot Magician above the cube by dragging the mouse and then place it 

close to the cube. 

�NOTE 

For details on how to use the mouse to control the robotic arm on the Mouse page, see 

Table 5.15. 

 

Table 5.15  The robotic arm’s movement created with your mouse 

Mouse action Robotic arm’s movement 

Move your mouse front, 

back, right, or left 

The robotic arm moves accordingly 

Scroll the mouse wheel 

up or down 

The robotic arm moves accordingly 

Press and hold the left 

mouse button 

Suction cup: the air pump sucks air in 

Gripper: increase holding force 

Release the left mouse 

button 

Suction cup: the air pump is powered off 

Gripper: open 

Right-click the mouse 

button 

Gripper: close 

 

 Step 4 Press and hold the left mouse button to control the air pump to suck air to move the 

mouse to drag the robotic arm to take the cube to another position, such as point B, 

and release the left mouse button, and the air pump stops working to drop the cube 

here. 

 Step 5 Press V or ESC to disable the mouse control. 

 Operating 3D Printing 5.9
After installing 3D printing kit, you can import 3D module into the 3D printing software for 

3D printing. Figure 5.116 shows the 3D printing process. 
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Figure 5.116  3D printing process 

 

During 3D printing, the 3D printing control software is required. You can use Repetier Host 
or Cura software for 3D printing. 

� Reptier-Host: Reptier-Host can slice with the third party slicing (such as 

CuraEngine, Slic3r, etc), check and modify G-Code, control 3D printing manually. 

More parameter settings make Reptier-Host very flexible. 

� Cure: The slicing of Cura is fast and stable. It has strong inclusiveness to 3D 

model structure and less parameter settings. 

NOTICE 

This section uses Windows as an example to describe how to perform 3D printing with 

Repetier Host and Cura. For Mac OS, only Cura is supported. 

 

 Installing 3D Printing Kit 5.9.1

3D printing kit contains extruder, hot end, motor cable, filament, and filament holder as 

shown in Figure 5.117. 
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Figure 5.117  3D printing kit 

Procedure 

 Step 1 Press down the lever on the extruder, and push down the filament to the bottom of 

the hole via the pulley, as shown in Figure 5.118. 
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Figure 5.118  Push down the filament 

 

 Step 2 Connec the end of the PTFE tube to the hot end and push it down to the bottom of 

the hot end, and connect the other end to the extruder, as shown in  

 

Figure 5.119  Connect extruder and hot end 

 

 Step 3 Insert the filament into the PTFE tube and push it down to the bottom of the hot 

end. 

NOTICE 

Please make sure that the PTFE tube has been pushed down to the bottom of the hot 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 104  

end. Otherwise, it will cause abnormal discharge. 

 

 Step 4 Fix the hot end on the Dobot Magician with butterfly nut, as shown in Figure 

5.120. 

 

Figure 5.120  Fix hot end 

 

 Step 5 Insert the heating cable to the interface 4 on the Forearm, the fan cable to the 

interface 5 and the thermistor cable to the interface 6, as shown in Figure 5.121. 
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Figure 5.121  Connect hot end to the Forearm 

 

 Step 6 Connect the extruder to the Stepper1 interface on the back of the base with motor 

cable, as shown in Figure 5.122. 

  

Figure 5.122  Connect with extruder 
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 Step 7 Place the filament and the extruder to the filament holder, as shown in Figure 

5.123. 

 

Figure 5.123  Place filament and extruder to the Filament holder 

 

 Operating Repetier Host 5.9.2

Repeiter Host has been built into DobotStudio. After burning 3D printing firmware, the 

Repetier Host page will be displayed automatically. 

Prerequisites 

� The 3D printing model has been prepared. 

� The printing platform has been prepared and please place it in the workspace of the 

Dobot Magician. 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully (Only USB 

connection is supported). 

� The 3D printing kit has been installed. 

5.9.2.1 Burning Firmware 
Procedure 

 Step 1 Click 3DPrinter on the DobotStudio page. 

The 3D Printing FM page is displayed, as shown in Figure 5.124. 
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Figure 5.124  Burn firmware 

 

 Step 2 Click Confirm to start burning 3D printing firmware. 

After burning 3D printing firmware, the Repetier Host page is displayed 

automatically, as shown in Figure 5.125. 

If the LED indicator on the base turns red, it indicates that the connection of the 3D 

printing kit is abnormal. 

WARNING 

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid 

machine damage. 

 

 

Figure 5.125  Repetier Host page 
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NOTICE 

If the current firmware is set for 3D printing when operating 3D printing, you can click 

Connect directly on the DobotStudio page. And then Click OK on the Select tool page 

to switch to Repetier Host, as shown in Figure 5.126. 

  

Figure 5.126  Switch into 3D printing automatically 

 

5.9.2.2 Performing 3D Printing 
Procedure 

 Step 1 Set printing parameters. 

Printing parameters only need to be set for the first time.  

 Click Printer Settings on the top right corner of the Pepetier Host page. 1.

The Printer Settings page is displayed. 

 Set the corresponding parameters on the Connection tab as shown in the red 2.

box of Figure 5.127. The other parameters are set by default. 
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Figure 5.127  Connection setting 

 

 Click Apply. 3.

 Unselect the corresponding options on the Printer tab as shown in the red box 4.

of, Figure 5.128 and the other parameters are set by default. Then, click Apply. 
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Figure 5.128  Unselect options 

 

 Set the corresponding parameters on the Extruder tab as shown in the red box 5.

of Figure 5.129, the other parameters are set by default. Then, Click Apply. 
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Figure 5.129  Extruder settings 

 

 Set the corresponding parameters on the Printer Shape tab as shown in the red 6.

box of Figure 5.130, the other parameters are set by default. Then, Click Apply. 
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Figure 5.130  Printer shape settings 

 

 Click OK 7.

 Step 2 Click Connect on the Repetier Host page to connect Dobot Magician. 

After the connection is successful, the current heating temperature will be shown 

on the below of the Repetier Host page, as shown in Figure 5.131. 

 

Figure 5.131  Connect to Dobot Magician 

 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 113  

 Step 3 Text extruder. 

Before printing, you need to test the extruder to check whether the melted filament 

flows from the nozzle of the extruder. 

The temperature of the extruder should be above 170 . Dobot Magician will not 

start 3D printing until the filament is in the melting state. So you need to heat the 

extruder first. 

 Set the heating temperature to 200  on the Manual Control tab of the 1.

Repetier Host page and click , as shown in Figure 5.132. 

DANGER 

The heating rod will produce high temperature up to 250 , please be careful. Do not 

let children play with it alone. The process needs to be monitored when it is running. 

After the process is completed, please turn off the equipment promptly. 

 

 

Figure 5.132  Heat the extruder 

 

 Click the extruder feeder when the heating temperature is up to 200  and feed 2.

up to10mm-30mm, as shown in Figure 5.133. 
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Figure 5.133  Extrude filament 

 

If the melted filament flows from the nozzle of the extruder, the extruder is 

working properly. 

 

NOTICE 

If the filament extrusion is in the opposite direction. Please remove the filament, and 

turn the extruder around, then re-push down the filament. 

 

 Step 4 Adjust the printing space and get the printing coordinates. 

�NOTE 

During printing, if the distance from Dobot Magician to the printing platform is too 

large or too small to paste the first layer, it can lead to the nozzle blockage. For 

increasing the stickiness of the first layer, placing a masking paper on the platform is 

recommended. 

 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the 1.

printing head contact the surface of the masking paper (The distance between 

the printing head and the surface of the masking paper is the thickness of a 

sheet of A4 paper), then release the Unlock key. 

 Input command M415 on the G-Code command window and press Enter to 2.
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get the current coordinates, as shown in Figure 5.134. 

Also, you can press the Key button on the bace of the base to get the current 

coordinates. 

 

Figure 5.134  Input M415 

 

�NOTE 

If you cannot find the G-Code command window, please click EASY to close Easy 
Mode, as shown in Figure 5.135. 

 

 

Figure 5.135  Easy mode 

 

 Step 5 Click Load to import the prepared 3D printing model, as shown in Figure 5.136. 
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The format of 3D model is STL. You can design 3D model and transform it into 

STL format. 

 

 

Figure 5.136  Import 3D printing Model 

 

After importing the model, you can center, zoom, or rotate the model on the 

Object Placement page, as shown in Figure 5.137. 

 

Figure 5.137  Model operation 
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 Step 6 Set slicing parameters and slice up. 

You need to set the slicing parameters before first printing. 

 Select Slic3r from Slicer on the Slicer tab of the Repetier Host page, and click 3.

Configuration, as shown in Figure 5.138. 

 

Figure 5.138  Select slicer 

 

The Slic3r page is displayed, as shown in Figure 5.139. 
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Figure 5.139  Slic3r page 

 

 Set the slicing parameters on the Slic3r page. 4.

The 3D printing effect depends on the slice parameters. This topic provides a 

configuration sample, you can select File > Load Config on the Slic3r page to 

import it directly for printing. 

The path of the configuration sample is Installation 
directory\DobotStudio\attachment, as shown in Figure 5.140. 

 

 

Figure 5.140  Configuration sample 

 

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini 
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is used for the filling, the filling rate is 20%. 

 Save the Printing Settings, Filament Settings and Printer Settings tabs 5.

respectively after importing configuration sample, as shown in Figure 5.141. 

 

Figure 5.141  Save configuration file 

 

 Click Slici with Slic3r on the Slicer tab of the Repetier Host page, as shown in 6.

Figure 5.142. 

 

Figure 5.142  Start to slice 

 

 Click  on the top left corner of the Repetier Host page to print. 7.
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Figure 5.143  Start printing 

 

Here we choose vase mode to print, and the product after printing as shown in Figure 5.144. 

 

Figure 5.144  The product of printing 
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 Operating Cura 5.9.3

If you need to use Cura software for 3D printing, please launch the Cura software after 

burning firmware. 

Prerequisites 

� Slice software Cura has been installed.  

The download path is https://ultimaker.com/en/products/ultimaker-cura-software/list. 

Please download the recommended version V14.07. The way how to install and use is 

not descripted in this topic. 

� The 3D printing model has been prepared. 

� The printing platform has been prepared and please place it in the workspace of 

Dobot Magician. 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully (Only USB connection 

is supported). 

� The 3D printing kit has been installed. 

5.9.3.1 Burning Firmware 
Procedure 

 Step 1 Click 3DPrinter on the DobotStudio page. 

The 3D Printing FM page is displayed, as shown in Figure 5.145. 

 

Figure 5.145  Burn firmware 

 

 Step 2 Click Confirm to start burning 3D printing firmware. 
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After burning 3D printing firmware, if the LED indicator on the base turns red, it 

indicates that the connection of the 3D printing kit is abnormal.. 

WARNING 

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid 

machine damage. 

 

5.9.3.2 Performing 3D Printing 
Procedure 

 Step 1 Launch Cura software. 

 Step 2 Set slicing parameters. 

 Select Machine > settings on the Cura page. 1.

The Machine settings page is displayed. 

 Set the corresponding parameters on the Machine settings and click OK, as 2.

shown in Figure 5.146. Table 5.16 lists the values of the parameters that need to 

be set. The other parameters are set by default. 

 

Figure 5.146  Parameters setting 

Table 5.16  3D printing parameters description 

Parameter Description 

Maximum width The maximum width 

please set to 80mm 

Maximum depth The maximum with  

please set to 80mm 

Maximum height The maximum height 

Please set to 150mm 

Machine center 0,0 Machine center, please select it 
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Parameter Description 

GCode Flavor The style of GCode 

Please select RepRap Marlin/Sprinter 

Build area shape Build the area shape 

Please select Circular 

Serial port Serial port 

Please select the corresponding serial port 

Baudrate Baud rate 

Please set to 115200 

 

 Set slice parameters, and select File > Open Profile to import these parameters, 3.

as shown in Figure 5.147. 

 

Figure 5.147  Import slice parameters 

 

The 3D printing effect depends on the slice parameters. This topic provides a 

configuration sample, you can import it directly for printing. 

The path of the configuration sample is Installation directory\DobotStudio 
\attachment\, as shown in Figure 5.148. 
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Figure 5.148  Configuration sample 

 

Dobot-2.0-Vase-Cura.ini is used for printing a thin-walled vase, while 

Dobot-2.0-Cura.ini is used for the filling, the filling rate is 20%. 

 Click , the Open 3D model page is displayed, and select the 3D 4.

printing model prepared. 

The format of 3D model is STL. You can design 3D model and transform it 

into STL format. 

After importing the model, click the model itself, you can center, zoom or 

rotate, and so on, as shown in Figure 5.149. 

 

Figure 5.149  Zoom and rotate 

 

 Click  to connect with Dobot Magician. 5.
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The printing window is displayed and the current printing temperature is 

shown on the top corner of the window, as shown in Figure 5.150. 

 

Figure 5.150  Printing window 

 

 Set Temperature to 200 and press down Enter to heat the extruder. 6.

The temperature of the extruder should be above 170 . Dobot Maigicain will 

not start 3D printing until the filament is in the melting state. So you need to 

heat the extruder first. 

DANGER 

The heating rod will produce high temperature up to 250 , please be careful. Do not 

let children play with it alone. The process needs to be monitored when it is running. 

After the process is completed, please turn off the equipment promptly. 

 

 Step 3 Test the extruder. 

Before printing, you need to test the extruder to check whether the melted filament 

flows from the nozzle of the extruder.  

Click the feedstock extruder or click the given stepper, such as 10, 1, 0.1 (10 is 

recommended) on the Operational page and feed up to 10mm-30mm, as shown in 

Figure 5.151. 
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Figure 5.151  Click feedstock extruder 

 

If the melted filament flows from the nozzle of the extruder, the extruder is 

working properly. 

 

NOTICE 

If the filament extrusion is in the opposite direction, please remove the filament, and 

turn the extruder around, then re-push down the filament. 

 

 Step 4 Adjust the printing space and get printing coordinates. 

�NOTE 

During printing, if the distance from Dobot Magician to the printing platform is too 

large or too small to paste the first layer, it can lead to the nozzle blockage. For 

increasing the stickiness of the first layer, placing a masking paper on the platform is 

recommende. 

 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the 1.

printing head contact the surface of the masking paper(The distance between 

the printing head and the surface of the masking paper is the thickness of a 

sheet of A4 paper), then release the Unlock key. 

 Input command M415 on the lower right of the Operational page to get the 2.

current coordinates, as shown in Figure 5.152. 

Also, you can press the Key button on the bace of the base to get the current 

coordinates. 
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Figure 5.152  Input command M415 

 

 Step 5 Click Print, Dobot Magician moves to the printing origin (System setting) and 

starts printing. 

 

 Calibration 5.10
 Base Calibration 5.10.1

The base Encoder has been calibrated before being shipped out. Generally, the J1-coordinate 

is 0° after homing, where the homing point is the system default. Namely, the Forearm is located 

at the middle in front of the base. 

If the J1-coordinate is not 0° (error range: 1 -3 ) after homing, you need to re-calibrate the 

base Encoder. 

Prerequisites 

� The writing and drawing kit has been installed. For details, please see 5.4.1 
Installing a Writing and drawing kit. 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

� The sensor calibration board has been prepared. 

Procedure 

 Step 1 Place the Dobot Magician at the right position on the sensor calibration board, as 

shown in Figure 5.153. 
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Figure 5.153  Location of Dobot Magician 

 

 Step 2  (Optional) Set the homing point and make the nib contact the surface of the 

calibration board. 

This step is used for observing the nib position on the calibration board when 

moving J1-axis in Step 5, to improve calibration accuracy. 

 Click Teaching&Playback on the DobotStudio page. 1.

The Teaching&Playback page is displayed. 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the nib 2.

contact the surface of the calibration board, then release the Unlock key. 

The coordinates of this point will be displayed on the Teaching&Playback 
page. 

 Select this point and right-click SetHome, as shown in Figure 5.154. 3.

  

Figure 5.154  Set homing position 
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 Step 3 Click Setting > Base Calibration on the DobotStudio page. 

The Base Calibration page is displayed. 

 Step 4 Click Next on the Base Calibration page. 

Dobot will start homing. Please ensure that there are no obstacles in the workspace 

during homing. 

 Step 5 Click +J1 or -J1 to make the nib at a point on the line between A3 and B3 on the 

calibration board, as shown in Figure 5.155 and Figure 5.156. 

If the speed is too fast when moving J1-axis, you can drag Speed slider to adjust 

speed. 

 

Figure 5.155  Move J1-axis 

 

 

Figure 5.156  Nib position 
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 Step 6 Click Calibration to start calibrating the base Encoder. 

You can check the J1-coordinate on the Operation Panel page, as shown in Figure 

5.157. 

 

Figure 5.157  J1-coordinate 

 

 Sensor Calibration 5.10.2

The angle sensors of the Forearm and Rear Arm have been calibrated before being shipped 

out. Generally, the Z-coordinate will remain the same when moving Dobot Magician in the same 

horizontal plane. If changed, you need to recalibrate the angle sensors by manual levelling or auto 

levelling to improve the positioning accuracy. 

� Manual Levelling: It is more accurate to calibrate manually with DobotStudio, 

sensor calibration board, and writing and drawing kit, which is suitable for the 

application scenarios with high requirements for absolute positioning accuracy. 

� Auto Levelling: It is simple and quick to calibrate automatically with DobotStudio 

and auto-levelling tool, which is suitable for the application scenarios without high 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 131  

requirements for absolute positioning accuracy, such as writing and drawing, 3D 

printing. 

5.10.2.1 Manual Levelling 
Prerequisites 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

� The sensor calibration board has been prepared. 

Procedure 

 Step 1 Place the Dobot Magician at the right position on the sensor calibration board, as 

shown in Figure 5.158. 

 

Figure 5.158  Location of Dobot Magician 

 

 Step 2 Click Setting > Manual Levelling on the DobotStudio page. 

The Manual Levelling page is displayed. 

 Step 3 Click Next on the Manual Levelling page. 

Dobot Magician will finish the auto-compensation of the angle senor coefficients of 

the Forearm and Rear Arm move according to the system settings. The result is as 

shown in Figure 5.159. 

NOTICE 

Please remove all end-effectors from Dobot Magician before calibrating 
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Figure 5.159  Get the angle sensor coefficients 

 

 Step 4 Click Next and set Angle Precision, Distance Precision, Result Range. 

In this step, please keep the default values, as shown in Figure 5.160. 

 

Figure 5.160  Set precisions 

 

 Step 5 Click Next and follow the instructions on the Manual Levelling page to move 

Dobot Magician to the first calibrated point. If the calibrated point is A3 on the 

Calibration board. 
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 Install the writing and drawing kit. For details, please see 5.4.1 Installing a 1.

Writing and drawing kit. 

 Press the Unlock key on the Forearm and drag Dobot Magician to make the nib 2.

near the A3 point on the calibration board, then release the Unlock key. 

 Click coordinate buttons on the Manual Levelling page (as shown in Figure 3.

5.161) to make the nib align to the center of A3 point on the calibration board, 

as shown in Figure 5.162. 

If the speed is too fast when clicking coordinate buttons, you can drag Speed 

slider to adjust speed. 

 

Figure 5.161 Fine-tune page 
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Figure 5.162  Nib position 

 

 Step 6 Click Next and follow the instructions on the Manual Levelling page (as shown in 

Figure 5.163) to move Dobot Magician to make the nib in the center of the second 

calibrated point. If the calibrated point is B3 on the calibration board, as shown in 

Figure 5.164. 

NOTICE 

Please DO NOT drag Dobot Magician in this step, to avoid manual levelling failure. If 

the speed is too fast when clicking coordinate buttons, you can drag Speed slider to 

adjust speed. 
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Figure 5.163  Fine-tune page 

 

 

Figure 5.164  Nib position on the second calibrated point 

 

 Step 7 Click Next and set the distance between the two calibrated points, as shown in 

Figure 5.165. 

The distance between the two calibrated points on the Calibration board is 80mm, 

so please keep the default value in this step. 
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Figure 5.165  Set the distance between the two calibrated points 

 

 Step 8 Click Next to start calibrating. 

The result is shown as Figure 5.166. 

 

Figure 5.166  Calibrating result 

 

5.10.2.2 Auto Levelling 
Prerequisites 
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� Dobot Magician has been connected to a PC via USB cable. 

� Dobot Magician has been connected to the power adapter. 

� The auto-levelling tool has been obtained, as shown in Figure 5.167. 

 

Figure 5.167  Auto-levelling tool 

 

Procedure 

 Step 1 Place Dobot Magician on the flat platform. 

NOTICE 

Please ensure that the platform is flat. Or, the auto levelling will be failed. 

 

 Step 2 Fix the auto-levelling tool on the Dobot Magician with butterfly nut, as shown in 

Figure 5.168. 
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Figure 5.168  Fix auto-levelling tool 

 

 Step 3 Insert the cable of the auto-levelling tool to the interface 2 on the Forearm, as 

shown in Figure 5.169. 

 

Figure 5.169  Insert the cable of the auto-levelling 
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 Step 4 Power on Dobot Magician and connect it to DobotStudio. 

 Step 5 Click Setting > Auto Levelling on the DobotStudio page. 

The Auto Levelling page is displayed, as shown in Figure 5.170. 

NOTICE 

Please ensure that there are no obstacles in the workspace during auto levelling. 

 

 

Figure 5.170  Auto levelling page 

 

 Step 6 Click Start on the Auto Levelling page. 

Dobot Magician starts auto levelling. The levelling process will takes about 2 

minutes. The result is shown as Figure 5.171. 

�NOTE 

If the auto levelling is failed, please check if the platform is flat and try again. 
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Figure 5.171  Auto levelling result 

 

 Homing 5.10.3

Dobot Magician has been calibrated before being shipped out. If the Dobot Magician has 

been hit or the motor has lost step, leading data abnormal, you need to operate homing to improve 

the positioning accuracy. 

Prerequisites 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

Click Home on the DobotStudio page, as shown in Figure 5.172. 

NOTICE 

� Please remove the end-effector from the Dobot Magician before homing. 

� Please ensure that there are no obstacles in the workspace during homing. 

 

 

Figure 5.172  Operate homing 

 

Dobot Magician will rotate clockwise to the limited position and then return to the default 

homing point automatically and the LED indicator on the base turns blue and is blinking. After the 
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homing is successful, there is a beep sound and the LED indicator turns green. 

Also, the homing point can be use-defined, you can select a saved point on the 

Teachong&Playback page and right-click SetHome to set this saved point as the homing point, 

as shown in Figure 5.173. 

 

Figure 5.173  Set homing point 

 

 Connecting with WIFI Kit 5.11
You can connect Dobot Magician to a PC via WIFI kit without USB cable, making Dobot 

Magician and PC in the same WLAN. Figure 5.174 shows the WIFI kit. 

 

Figure 5.174  WIFI kit 

Prerequisites 

� Dobot Magician has been connected to a PC via USB cable. 
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� Dobot Magician has been connected to the power adapter. 

� The WIFI name and password have been obtained and must be the same as that of 

PC. 

Procedure 

 Step 1 Connect the WIFI kit to the UART interface on the base, as shown in Figure 5.175. 

 

Figure 5.175  Connect with WIFI kit 

 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device 

 Step 2 Press down the power button to turn on the Dobot Magician. 

After turning on, there are two short beep sounds and the blue LED indicator on the 

WIFI module is on. 

 Step 3 Select the corresponding serial port from the serial drop-down list, and click 

Connect. 

 Step 4 Click Setting > Wi-Fi. 

The Set Dobot Wi-Fi page is displayed. 

 Step 5 Set the related parameters on the Set Dobot Wi-Fi page. 

In this topic, please select Dynamic Host Configuration Protocol (DHCP) and 

set SSID and Password to obtain the IP address of Dobot Magician, as shown in 

Figure 5.176. 

If you unselect Dynamic Host Configuration Protocol (DHCP), you need to set 
IP address, Netmask, Gateway. For details, please see Table 5.17. 
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Figure 5.176  Set WIFI 

 

Table 5.17  Parameter description 

Parameter Description 

SSID Set WIFI name 

The WIFI name and password have been obtained and must be the same as 

that of PC 

Password Set WIFI password 

Dynamic Host Configuration 

Protocol (DHCP) 

Whether to select DHCP 

Yes: Only set SSID and Password 

No: Only set IPAddress, Netmask and Gateway 

IPAddress Set the IP address of Dobot Magician. The IP address of Dobot Magician and 

the PC must be in the same WLAN without conflict. 

Netmask Set subnet mask 

Gateway Set gateway 

DNS Set DNS 

 

 Step 6 Click OK. 
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About 5 seconds later, the green LED indicator on the WIFI module is on, 

indicating that the Dobot Magician has been connected with WLAN, as shown in 

Figure 5.177. 

 

Figure 5.177  Status of LED indicator 

 Step 7 Click Disconnect on the left pane of the DobotStudio page. 

 Step 8 After 2 seconds later, select the IP address from the drop-down list on the upper left 

pane of the DobotStudio page and click Connect, as shown in Figure 5.178. 

 

Figure 5.178  IP address of Dobot Magician 

 

After the connection is successful, you can control Dobot Magician without USB 

cable. 

 Connecting with Bluetooth Kit 5.12
Dobot Magician can be connected to smart phone with Bluetooth. Figure 5.179 shows the 

Bluetooth kit. Please download the matched DobotStudio APP from the website 

https://cn.dobot.cc/downloadcenter.html?sub_cat=69#sub-download. 
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Figure 5.179  Bluetooth kit 

 

Prerequisites 

� Dobot Magician has been connected to the power adapter. 

� The DobotStudio APP has been downloaded. 

Procedure 

 Step 1 Connect the Bluetooth kit to the UART interface on the base, as shown in Figure 

5.180. 
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Figure 5.180  Connect with Bluetooth kit 

 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device. 

 

 Step 2 Press down the power button to turn on the Dobot Magician. 

After turning on, there are three short beep sounds and the blue LED indicator on 

the Bluetooth module is on and the green one is blinking. 

Turn on the Bluetooth and launch DobotStudio APP on your phone. And click 

Connect to connect with Dobot Magician. 

This topic only describes how to connect Bluetooth kit. For details how to operate 

Dobot Magician with DobotStudio APP, please see 

https://www.youtube.com/watch?v=kyeXwuf17IY. 

 Operating Blockly 5.13
Blockly is a programming platform based on Google Blockly. You can program through the 

puzzle format, which is straightforward and easy to understand.  

Prerequisites 
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� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Step 1 Click Blockly on the DobotStudio page. 

The Blockly page is displayed. 

 Step 2 Drag the blockly module on the left pane of the Blockly page to program, as shown 

in Figure 5.181. 

 

Figure 5.181  Blockly graphic programming 

 

Table 5.18 lists the description of blockly module. 

Table 5.18  Blockly description 

No. Description 

1 The selection area of blockly module, including 

logistic, loop, math, and Dobot API. You can program 

by dragging them to the window. 

2 The window of blockly programming 

3 The running log of Dobot Magician 

4 The corresponding codes of the blockly module on the 

programming window 

 

The demo in Figure 5.181 is described as follows. 

 Set the end-effector as Gripper. 1.

 Set the loop number as 3 and make the Z-axis move back and forth 3 times. 2.

 Set the pause time as 3. 3.

 Step 3 Click Save on the Blockly page. 

The Saving Blockly file page is displayed. 

 Step 4 Input the use-defined name and the saving path, and click Save. The default path of 



 Dobot Magician User Guide 5 Operation

Issue V1.0 (2018-06-12) User Guide Copyright © Yuejiang Technology Co., Ltd. 

 148  

the programing file is Installation directory/DobotStudio/config/bystore. Please 

replace the path based on site requirements. 

 Step 5 Click Start on the Blockly page, and Dobot Magician will move according to the 

program. 

 

 Scripting 5.14
You can control Dobot Magician over scripting. Dobot Magician supports various API, such 

as velocity/acceleration setting, motion mode setting, and I/O configuration, which uses Python 

language for secondary development. For details about the Dotob Magician API interface and 

function description, please see Dobot Magician API Description.  

The download path is 

https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download. 

Prerequisites 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Step 1 Click Script on the DobotStudio page. 

The Script page is displayed. 

 Step 2 Write a script. 

You can call the interface by double-clicking on the left pane of the Script page, 

the corresponding interface will be displayed on the middle pane, as shown in 

Figure 5.182. You can also click  icon of the corresponding interface to view 

the way how to set the parameters. The scripting examples (including Jog, PTP, and 

Pallet) can refer to Installation directory/DobotStudio/config/ststore/. 

 

 

Figure 5.182  Write a script 
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 Step 3 Click Save on the Script page. 

The Saving Scrip File page is displayed. 

 Step 4 Input the use-defined name and the saving path, and click Save. 

The default path of the script is Installation directory/DobotStudio/config/ststore. 

Please replace the path based on site requirements. 

 Step 5 Click Start, and Dobot Magician will move according to the script file. 

The running log will be displayed on the lower pane of the Script page for 

checking. 

 

 Operating Stick Controller Kit 5.15
Dobot Magician can be controlled by stick controller kit without DobotStudio. Figure 5.183 

shows the stick controller kit. From left to right: Stick controller, USB Host module, USB cable 

(used for charging stick controller), Transceiver. 

 

Figure 5.183  Stick controller kit 

Prerequisites 

� Dobot Magician has been connected to a PC over USB cable. 

� Dobot Magician has been connected to the power adapter. 

Procedure 

 Step 1 Connect the transceiver to the USB module. 

 Step 2 Connect the USB Host module to the UART interface on the base, as shown in 

Figure 5.184. 
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Figure 5.184  Connect with USB Host module 

 

 Step 3 Press down the power button to turn on the Dobot Magician. 

The blue LED indicator on the USB Host module is on. After turning on, there are 

four short beep sounds and the green one is on. 

NOTICE 

Please turn off the Dobot Magician completely first before connecting or disconnecting 

external equipment. Or, it causes serious damage to your device. 

 

 Step 4 Press down the power button on the stick controller, as shown in Figure 5.185. 

The red LED indicator on the middle of the stick controller is blinking, indicating 

that the Dobot Magician can be controlled by the stick controller. 
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Figure 5.185  Power button of the stick controller  

 

Table 5.19 lists the functions of buttons on the stick controller. 

Table 5.19  Button function 

Button Function 

Power button Turn on stick controller 

The stick controller will turn off automatically 

LT Turn on the peripheral motor 

RT Turn off the peripheral motor off 

RB Switch to Cartesian coordinate system mode 

LB Switch to Joint coordinate system mode 

X Control the outtake of the air pump 

Y Control the intake of the air pump 

B Turn off the air pump 

Left stick: Front/back � Cartesian coordinate system mode: Dobot 

Magician moves along X-axis in the 

positive/negative direction 

� Joint coordinate system mode: Dobot Magician 

rotates along J1-axis in the 

positive/negative direction 

Left stick: Left/right � Cartesian coordinate system mode: Dobot 

Magician moves along Y-axis in the 
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Button Function 

positive/negative direction 

� Joint coordinate system mode: Dobot Magician 

rotates along J2-axis in the 

positive/negative direction 

Right stick: Front/back � Cartesian coordinate system mode: Dobot 

Magician moves along Z-axis in the 

positive/negative direction 

� Joint coordinate system mode: Dobot Magician 

rotates along J3-axis in the 

positive/negative direction 

Right stick: Left/right � Cartesian coordinate system mode: Dobot 

Magician rotates along R-axis in the 

positive/negative direction 

� Joint coordinate system mode: Dobot Magician 

rotates along J4-axis in the 

positive/negative direction 

 

 Multiplexed I/O Demo 5.16
The addresses of the I/O interfaces in Dobot Magician are unified. Most of I/O interfaces 

have multiple functions. For details, please see 4.3 Multiplexed I/O Interface Description.  

You can set I/O interfaces on the advanced Teaching&Playback page to control the 

peripheral equipment, as shown in Figure 5.186. 

 

Figure 5.186  I/O setting page 

 

Now, demos of level output, level input, and PWM output are given below. 
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 Level Output 5.16.1

Normally, air pump can be controlled by the I/O interfaces. The I/O 11 controls its intake 

(High level) and outtake (Low level) and the I/O 16 controls its start-stop. Table 5.20 lists the 

multiplexed descriptions of I/O 11 and I/O 16. 

Table 5.20  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC

11 3.3V √ √ - - 

16 12V √ - - - 

 

The I/O 11 and I/O 16 are located at the peripheral interface of the base, as shown in Figure 

5.187. 

 

Figure 5.187  Peripheral Interface on the base 

 

Prerequisites 

� The air pump has been connected to Dobot Magician. For details, please see 5.2.1 
Installing a Suction Cup Kit. 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Step 1 Select Pen from the end-effector drop-down list on the DobotStudio page, as 

shown in Figure 5.188. 
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Figure 5.188  Select end-effector 

 

NOTICE 

Normally, If SuctionCup or Gripper is selected from the end-effector drop-down list 

after the air pump has been connected, the air pump will be controlled by the system. In 

this topic, we use I/O interfaces to control the air pump, so SuctionCup and Gripper 
cannot be selected, to avoid conflict. 

 Step 2 Click  icon on the Teaching&Playback page, as shown in Figure 

5.189. 

 

Figure 5.189  Switch advanced function 

 

 Step 3 Select IO_11, IO_16 and their corresponding Value on the Output pane, and click 
+Point. 

The saved point is displayed on the Teaching&Playback page, as shown in 

Figure 5.190. 

�NOTE 

If the intake is not obvious, please modify PauseTime of this saved point. 
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Figure 5.190  Saved point 

  

 Step 4 Select this point and click StepRun. 

The air pump is humming with intake. 

 Step 5 Select IO_11, IO_16 and the corresponding Value of IO_16 on the Output pane, 

and click +Point. 

The saved point is displayed on the Teaching&Playback page, as shown in Figure 

5.191. 

 

Figure 5.191  Saved point 

 

 Step 6 Select this point and click StepRun. 

The air pump is humming with outtake. 

 Level Input 5.16.2

This topic also takes I/O 12 as an example.  
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Table 5.21  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC

12 3.3V - - √ - 

 

Prerequisites 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

� The saved points list has been existed on the Teaching&Playback page. 

Procedure 

 Step 1 Click  icon on the Teaching&Playback page, as shown in Figure 

5.192. 

 

Figure 5.192  Switch advanced function 

 

 Step 2 Select a saved point on the Teaching&Playback page. 

 Step 3 Select EIO11_Input on the Trigger pane, and set Condition and its Value.  

Here, Value only can be set to 0 or 1. 1: High level; 0: Low level. 

 

 Step 4 Click ADD, as shown in Figure 5.193. 

 

Figure 5.193  Saved point 
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 PWM OUTPUT 5.16.3

This topic also takes I/O 11 as an example. 

Table 5.22  Multiplexed I/O description 

I/O addressing Voltage Level Output PWM Level Input ADC

11 3.3V √ √ - - 

 

Prerequisites 

� Dobot Magician has been powered on. 

� Dobot Magician has been connected to DobotStudio successfully. 

Procedure 

 Step 1 Click  icon on the Teaching&Playback page, as shown in Figure 

5.194. 

 

Figure 5.194  Switch advanced function 

 

 Step 2 Select IO_11 on the Output pane, and click +Point, as shown in Figure 5.195. 

 

Figure 5.195  Saved point 

 

 Step 3 Double-click EIO11 cell and select … from the drop-down list. 

The EIO Setting page is displayed, as shown in Figure 5.196. 
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Figure 5.196  EIO setting 

 

 Step 4 Set Frequency (Unit: KHZ; Value range: 10HZ-1MHZ) and DutyRatio 
(0%-100%) on the EIO Setting page. 
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This device complies with Part 15 of the FCC rules. Operation is subject to the 
following two conditions: 1) this device may not cause harmful interference, and 2) 
this device must accept any interference received, including interference that may 
cause undesired operation.
Note: This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
--Reorient or relocate the receiving antenna.
--Increase the separation between the equipment and receiver.
--Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.
--Consult the dealer or an experienced radio/TV technician for help.
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

FCC Radiation Exposure Statement

This device complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. This transmitter must not be co-located or operating in 
conjunction with any other antenna or transmitter.
This device must operate with a minimum distance of 20 cm between the radiator 
and user body.

IC Note:
This device complies with Industry Canada's licence-exempt RSSs. Operation is subject to the
following two conditions:
(1) This device may not cause interference; and
(2) This device must accept any interference, including interference that may cause undesired
 operation of the device.

Cet appareil est conforme aux CNR exemptes de licence d'Industrie Canada . Son fonctionnement 
est soumis aux deux conditions suivantes :
(1) Ce dispositif ne peut causer d'interférences ; et
(2) Ce dispositif doit accepter toute interférence , y compris les interférences qui peuvent causer 
un mauvais fonctionnement de l'appareil.

FCC Statement

IC Note:

FCC Statement

For Bluetooth kit and WIFI kit:


